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Once youôve logged into your WordPress site via the login form, you should be presented 

with the WordPress Dashboard, which is your siteôs admin area. WordPress dashboard 

is the interface where administrators or other users manage website page, posts and 

perform other tasks. So letôs dig right iné 

4.1 What is the WordPress Dashboard?  

WordPress dashboard is the interface that appears when you log in to your WordPress 

website by appending wp-admin to the URL of your website. Hence if your website is 

https://www.example.com/ The WordPre ss dashboard login URL for this website would 

be https://www.example.com/wp -admin/  

 

The dashboard contains various settings which help you set up your website efficiently 

and modify several aspects of your site without needing to FTP to your site or touch the 

WordPress database. 

Your WordPress administration section is where all of your siteôs administration is 

controlled from. Your Dashboard is divided into several areas that provide you with 

access to tools and features such as: 
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¶ Useful data and informati on about what is taking place on your site. It also 

provides you with ñat-a-glanceò metrics and reports about recent activity taking 

place on your site, system updates, and notifications, and to be kept updated on 

the latest news from the WordPress community and various WordPress-related 

resources, such as notifications and announcements from WordPress product 

vendors of plugins and themes that you have installed on your site. 

¶ Management and control of all website settings and options. 

¶ Features that let you modify, expand, update and enhance the design and 

functionality of your site, upgrade plugins and themes, and add, modify and 

delete content or content sections. 

In version 3.8, WordPress introduced new design changes to its backend section é 

 

Even though this new design was mostly cosmetic and aimed at giving WordPress users 

and developers cleaner typography for a better optimized mobile and desktop viewing 

experience and a more aesthetic experience, it also affected much of the existing 

WordPress documentation around the web, including thousands of tutorials and articles 

about WordPress online, in print and on video that are now in need of being updated. 

4.2 Your WordPress Dashboard  
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Depending on whether you or someone else manages your site, you may or may not see 

the messages below. The first time you log into your WordPress site, you may see a 

ñWelcome to WordPressò message displayed at the top of the Dashboardé 

If you are new to using your website and want to spend a little time learning more about 

WordPress, just click on the ñGet Startedò or ñNext Stepò links. To dismiss the 

ñWelcomeò message or prevent it from showing again inside your admin area the next 

time you log in, click on the Dismiss link near the top  right -hand corner of the pageé 

Feel free to explore the information displayed in the ñwelcomeò message if you want to 

learn about new features and updates to the software. To go back to the dashboard, just 

select ñDashboardò (or click on Dashboard > Home) on the admin menu sectioné 

Or scroll down to the bottom of the page and click on the link to dismiss the message 

and return to your main Dashboardé 

4.3 WordPress Dashboard Screen Areas  

Your Dashboard gives you access to all of the main controls and features that you will 

need to administrate the siteé 

Your main Dashboard screen is divided into the following sections: 

¶ Header And Toolbar Section (1) 

¶ Main Navigation Menu (2)  

¶ Work Area (3) 

¶ Footer Section (4) 
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4.3.1 WordPress Dashboard Area: Header Section  

The header section displays system updates, messages, warnings and notifications. A 

whole range of updates, messages, banner, announcements, notifications, and warnings 

can display on your header, depending on what area you are working on, what action 

has been performed, or which plugins you have installed on your site. 

¶ Screen Options Feature  

The Screen Options tab is located in the top-right corner of your WordPress 

administration screen, in the header section. Clicking on this tab displays different 

options and features on your screen, depending on which section of the administration 

backend you are currently working on.  

For example, if you are in the main Dashboard, clicking on the Screen Options tab 

allows you to configure options like which panels of your Dashboard screen you want to 

hide or display. If you are in the Posts section of your site management area, clicking on 
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the Screen Options tab lets you select totally different options, such as displaying or 

hiding information in the listings se ction (e.g. tags, comments, etc.), specifying the 

number of posts to display per page, and other configurable options depending on the 

plugins you have installed on your site. 

¶ Online Help Section  

You can access the official WordPress documentation and user help forum sections by 

clicking on the Help tab lo cated on the top right-hand corner of your header area. 

Like the Screen Options tab, the Help tab also displays context-specific information.  So, 

for example, if you are editing content in the Edit Post area, clicking on the Help tab will 

bring up help inf ormation and tutor ials relevant to editing posts. 

4.3.2 WP Admin Area: Toolbar  

The Toolbar displays at the very top of your Dashboard screen and provides you and 

your logged in site users with access to a range of important administration functions, 

features, information and ñquick linksò to other areas of your site. Most Toolbar items 

can expand to display additional information by hovering your mouse ove r the icons. 

 

For example, the ñupdatesò icon on the toolbar lets you see if the WordPress software or 

any plugins or themes need to be updated. You can also see at a glance how many 

comments are awaiting moderation, create new posts or pages, add new media or links 

into your content, add new users to your site and a whole lot more. 

4.3.3 WordPress Admin A rea: Navigation Menu  
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On the left side of the Dashboard is the main navigation menu that contains links to all 

the administrative functions that you can perform on your website.  

Keep in mind that what users see inside the Dashboard area when logged in depends on 

the role and capabilities assigned to them and how the site administrator has configured 

settings and options for different features.  

In order to access all of the WP control area features, you must be an administrator of 

the site. 
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Users with roles other than that of an administrator (e.g. ñSubscriberò, ñAuthorò, etc.) 

get access to fewer menu options inside the dashboard.  

Irrespective of the role assigned to a user, some admin menu items like ñCollapse menuò 

remain accessible to all. Click the Collapse menu button at the bottom of the menu bar. 

And the admin menu collapses into a narrow band with only a set of icons displaying for 

all functions.  

 

This is a useful feature if you want more space in your admin working area. If you are 

working with t he collapsed menu and are not sure what the icons mean, just click the 

bottom icon to expand all items, or hover over an icon to display its submenus. 

If you hover your mouse over a menu item, a submenu will fly out. To stickò sub-menus 

into the navigation  menu bar while youôre working, click on a menu item.  

4.3.4 WordPress Admin Area: Working Area  
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The large area in the middle of your admin screen is your main work area. This is where 

you will get access to most of your siteôs information, do most of your admin work, 

create, modify and delete pages, posts and content related to these, upload images and 

media to your site, add, update and configure plugins and themes, change your site 

options, etc. 

When you log into your site, your Dashboard displays a number of panels with 

information about various activities taking place on your site, including updates and 

notices from several sources. 

 

As you get busier and start adding more content and functionality (e.g. adding e-

commerce or a support helpdesk, etc.) and more users begin to interact with your site, 

this section will start looking very busy . 

Fortunately, you can customize your admin area by hiding, minimizing and reorganizing 

the layout and display of your information sections.  For a quick and easy tutorial on 

ways to customize your WordPress Dashboard, go here: Customizing The WordPress 

Dashboard Section. 

4.3.5 WordPress Administration Area: Footer  
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The footer section is found at the bottom of your WP Dashboard area and displays a link 

to WordPress and your siteôs current WordPress software version.  

 

Conclusion:  

As you can see there is a lot of useful information on the WordPress Dashboard that you 

can use. So make full use of the Dashboard. 
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WordPress Plugins allows you to easily modify, customize, and enhance a WordPress 

site. Instead of changing the core program code of WordPress, you can add functionality 

with WordPress Plugins.  

If youôre new to WordPress, you might find yourself wondering, ñwhat is a WordPress 

plugin?ò. Itôs a fairly common question to ask because, in addition to being one of the 

many new terms that WordPress will introduce to your vocabulary, plugins are also an 

essential building block of every single WordPress site. Here is a basic definition.  

5.1 WordPress  Plug -ins  

A plugin is a piece of software containing a group of functions that can be added to a 

WordPress website. They can extend functionality or add new features to your 

WordPress websites. 

 

WordPress plugins are written in the PHP programming languag e and integrate 

seamlessly with WordPress. In the WordPress community, there is a saying that goes 

around: ñthereôs a plugin for thatò. They make it easier for users to add features to their 

website without knowing a single line of code. 
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There are thousands of WordPress plugins available for free at the official WordPress 

plugin directory. Aside from free plugins, there are tons of amazing commercial ones 

available from third -party companies and developers. 

As a site administrator, you can install/uninstall  plugins from the admin area. You can 

also download and manually install them using an FTP client.  

Because the vast majority of plugins are free, it is important to note that they usually do 

not come with tech support. For this reason, it is important to b e careful when choosing 

which ones you want to install on your site. 

Although there are plugins that can do the task you want them to do, some are much 

higher quality than others. In order to choose the right ones, you should ask yourself a 

couple of questions. 

How long has it been since it was updated? Is it compatible with the latest version of 

WordPress? Are people getting answers to their support questions? What type of rating 

does it have? 

There is a myth that WordPress plugins slow your site down. It is not true. Only the 

number of bad ones will slow down your site. 

5.2 How to Install a WordPress Plugin ï Step by Step for Beginners  

After installing WordPress, the first thing every beginner needs to learn is how to install 

a WordPress plugin. Plugins allow you to add new features to WordPress such as add a 

gallery, slideshow, etc. There are thousands of free and paid plugins available for 

WordPress. But before you start, if you are using WordPress.com, then you cannot 

install plugins.  WordPress.com has its limitations.  You cannot install plugins on 

WordPress.com unless you upgrade to their business plan. On the other hand, you can 

install any plugin you want on your self -hosted WordPress.org website right out of the 

box. 

Installing a WordPress plugin invo lves three methods: 

¶ Installing a WordPress plugin using search  
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¶ Uploading a WordPress plugin 

¶ Manually installing a WordPress plugin using FTP  

5.2.1 Install a Plugin using WordPress Plugin Search  

The easiest way of installing a WordPress plugin is to use the plugin search. The only 

downside of this option is that a plugin must be in the WordPress plugin directory which 

is limited to only free plugins.  

First thing you need to do is go to your WordPress admin area and click on Plugins » 

Add New. 

 

You will see a screen like the one in the screenshot above. Find the plugin by typing the 

plugin name or the functionality you are looking for like we did. After that, you will see a 

bunch of listings like the example below: 
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You can pick the plugin that is best for you. Since in our search, we were looking for 

Floating Social Bar which happens to be the first plugin, we will click the óInstall Nowô 

button. WordPress will now download and install the plugin for you. After this, you will 

see the success message with a link to activate the plugin or return to plugin installer.  

A WordPress plugin can be installed on your site, but it will not work unless you activate 

it. So go ahead and click on the activate plugin link to activate the plugin on your 

WordPress site. Thatôs all; you have successfully installed your first WordPress plugin. 
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The next step is to configure the plugin settings. These settings will vary for each plugin, 

therefore, it cannot be discussed in general. 

5.2.2 Install a Plugin using the WordPress Admi n Plugin Upload  

Paid WordPress plugins are not listed in the WordPress plugin directory. These plugins 

cannot be installed using the first method.   

Thatôs why WordPress has the Upload method to install such plugins. We will explore 

how to install WordPress plugins using the upload option in the admin area.  

First, you need to download the plugin from the source (which will be a zip file). Next, 

you need to go to the WordPress admin area and visit Plugins » Add New page. 

After that, click on the Upload Plugin  button on top of the page. 
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This will bring you to the plugin upload page. Here you need to click on the choose file 

button and select the plugin file you downloaded earlier to your computer.  
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After you have selected the file, you need to click on the install now button.  

WordPress will now upload the plugin file from your computer and install it for you. You 

will see a success message like this after the installation is finished. 

 

Once installed, you need to click on the Activate Plugin link to start using the plugin.  

You would have to configure the settings to fit your needs. These settings will vary for 

each plugin, therefore, it cannot be discussed in general terms. 

5.2.3 Manually Install a WordPress Plugin using FTP  

In some cases, your WordPress hosting provider may have file restrictions that could 

limit your ability to install a plugin from the admin area.  

In this situation, your best bet is to install the plugin manually using FTP. The FTP 

manager method is the least friendly for beginners. 

First , you will need to download the pluginôs source file (it will be a zip file). Next, you 

need to extract the zip file on your computer. 

Extracting the plugin zip file will create a new folder with the same name. This is the 

folder that you need to manually up load to your website using an FTP client. 
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You would need to access your host through the FTP manager. If you do not have your 

FTP username and password, then contact your WordPress hosting provider and ask 

them. 

Open the FTP client on your computer and connect to your website using the login 

credentials provided by your web host. Once connected, you need to access the path 

/wp -content/plugins/  

Next, upload the folder you extracted from the zip file to the /wp -content/plugins/ 

folder on your web server. 

 

After uploading the files, you need to visit the WordPress admin area and click on the 

Plugins link in the admin menu. You will see your plugin successfully installed on the 

plugins page.  
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You need to click on the Activate link below the plugin. Upon activating, you may need 

to configure the plugin settings. WordPress plugins come with their own settings which 

differ from one plugin to another .  

5.3 Best WordPress Plugins  for Your Site  

Having the right set of WordPress plugins and tools can help you grow your online 

business. There are all-star plugins that can help with content strategy, SEO, site 

security and even Facebook Messenger marketing.  

There are over 54,000+ WordPress plugins that you can choose from. This makes it 

extremely overwhelming for new users to find the right plugin for their website.  

Here we have the list of 10 best WordPress plugins to add to your website: 

1. MobileMonkeyôs WP-Chatbot  
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Want to connect your business with the 1.3 billion+ users on Facebook 

Messenger?  

Then power your site with MobileMonkey's WP-Chatbot. 

It's just like a traditional website chat where users can chat with a support team 

or get answers to questions, but with the added benefit of getting information on 

every single one of those users. 

 

When a user chats with a MobileMonkey -powered site chat, the conversation 

they're having is being facilitated through Facebook Messenger. 

That's means every chat bubble conversation will have a history. 

More importantly, you can add forms where users can automatically add their 

info rmation, making it simple for you to gather data on your customers and 

follow up with them.  

2.  Yoast SEO  

This is one of the best on-page SEO plugins for WordPress sites. Yoast SEO 

shows how SEO-friendly your post is and gives recommendations for how to 

improv e it. Among other things, it will analyze your keyword use, your metadata, 

and the readability of your content.  
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3.  Jetpack  

Itôs the all-in-one features package for every WordPress site, made by the 

WordPress team. Jetpack is a must-have plugin, giving WordPress users 

numerous powerful features. 

It takes care of website security, performance, traffic growth, image optimization, 

design, etc. 

4.  Akismet Anti -Spam  

This plugin tends to be automatically installed along with WordPress. Akismet is 

your main safeguard against spam comments on your WordPress site. 

It filters out comments that are spammy with illicit links, inappropriate 

messages, and such. You can also see a status history for each comment, so you 

can know where they come from. If you need more powerful features for a 

commercial website, thereôs a premium option. 
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5.  WooCommerce  

If youôre looking to build an online store, then this is the WordPress plugin you 

should install. WooCommerce is the No. 1 plugin for e-commerce in WordPress. 

You can install it and easily set it up to add product listings and shopping cart in 

your website. It has features for providing customers with multiple options in 

shipping, payment methods, etc. There is also an online community of 

WooCommerce users worldwide you can interact with.  

6.  Wordfence Security  

Website security is something most people take for granted -; until they get 

hacked. This WordPress plugin guard against hacking with real-time monitoring 

and protection.  

It also has firewall protection, malware scan, blocking, logi n security, and many 

other features. Wordfence also logs real-time activities on your website, so you 

can always keep an eye on things. 

7. Google XML Sitemaps  

Setting up Google XML sitemaps and getting them just right can be tedious. This 

plugin creates your XML sitemap for you and ensures your website will be 

indexed by all the major search engines. 

 

Save time and effort in your websiteôs SEO initial setup with this plugin. 
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8.  WPForms  

If you need to add forms in posts and pages, nothing comes close to WPForms. 

Itôs the most beginner-friendly plugin for building forms in WordPress. WPForms 

has a drag-and-drop interface that lets you create a contact form easily. 

This plugin has a lite version you can try out and keep using for free if it satisfies 

your needs. If you want more features, then you can go for the pro version. That 

paid version lets you collect payments, conduct surveys, take job applications, 

and so on. 

9.  MonsterInsights  

This plugin makes your Google Analytics visible through your WordPress 

dashboard. It's quick and easy to connect Google Analytics, and once it's set up, 

it's so convenient to see your data within Wordpress. 

There's a 100% free lite version (woot!), as well as a pro version with more robust 

metrics for publisher and e-commerce sites.   

10.  Redirection  

There may be times you have to change the permalinks of your posts or pages. 

But every now and then, you forget to redirect them since that can get pretty 

tedious. 

This aptly-named plugin lets you manage all the 301 redirects and 404 errors in 

your site. You can then redirect all those faulty URLs and have full logs of all the 

redirects. This plugin is especially useful when you make big changes to your 

WordPress site. 

Conclusion:  

Plugins are the add-ons that enable you to expand your siteôs functionality and make it 

do just about anything youôd like. You can find plugins that help you build and optimize 

your site, maintain it over time, and add new features such as contact forms storefronts.  
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Often WordPress beginners get confused between posts and pages. By default, 

WordPress comes with two content types: posts and pages. 

As a beginner, you are probably wondering whatôs the difference between posts vs 

pages? They seem to look similar in the WordPress dashboard as well as on the website. 

7.1 What are Posts in WordPress?  

Posts are blog content listed in reverse chronological order (newest content on top). You 

will see posts listed on your blog page. If you are using WordPress as a blog, then you 

will end up using posts for the majority of your websiteôs content. 

You can add and edit your WordPress posts from the óPostsô menu in your dashboard. 

Here is how Add New Post screen looks. 

 

Due to their reverse chronological order, your posts are meant to be timely. Older posts 

are archived based on month and year. As the posts get older, the user has to dig deeper 

to find them. You have the option to organize your posts based on categories and tags. 
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Because WordPress posts are published with time and date in mind, they are syndicated 

through the RSS feeds. This allows your readers to be notified of the most recent post 

update via RSS feeds. 

Bloggers can use the RSS feeds to deliver email broadcasts through services like 

Constant Contact, Aweber or MailChimp. You can create a daily and weekly newsletter 

for your audience to subscribe to. 

The very timely nature of posts makes it extremely social. You can use one of the many 

social sharing plugins to allow your users to share your posts on social media networks 

like Facebook, Twitter, LinkedIn, Pinterest , etc. 

Posts encourage conversation. They have a built-in comment feature that allows users to 

comment on a particular topic. By default, comments, pingbacks, and trackbacks are 

enabled. 


